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This tutorial shows you how to design and make a test probe with PCB Wizard. You should follow 
this tutorial to learn the basic skills you will need to use PCB Wizard effectively.

Difficulty Level: Advanced (suitable for experienced users)

Components

To make this circuit you will need:

14-pin dual-in-line (DIL) socket
4011B integrated circuit (IC)
Red LED
Green LED
2 x 680 ohm resistors:

Blue, Grey, Brown and Gold (4 band)
Blue, Grey, Black, Black and Gold (5 band)

120K ohm resistor:
Brown, Red, Yellow and Gold  (4 band)
Brown, Red, Black, Orange and Gold (5 band)

PP3 battery and clip

plus suitable PCB making equipment

Completed circuit

At the completion of this tutorial, 
you will have drawn both a circuit 
diagram (a) and a printed circuit 
board (PCB) layout (b) for a test 
probe circuit.

Getting started

You will design and make a test probe.

Once built, the test probe can be used to 
identify the most common circuit problems 
such as broken tracks, faulty components 
and loose connections.

Along the way, you will learn how to:

Add components from the Gallery
Change component values and models
Convert the circuit into a PCB layout
Automatically route the circuit
Make a non-rectangular board
Add a solid copper area
Add text to the board
View how the finished PCB will look

Step 1 of 10: Introduction

(b)

(a)
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You will begin by creating a new (empty) document in which to draw your circuit. To create a new 
document, click on the New button or choose New from the File menu.

Next you will learn how to use the Gallery to add components 
to your circuit. If the Gallery is not currently open, click on the 
Gallery button on the top toolbar to open it. Select the Circuit 
Symbols option.

In the Circuit Symbol Gallery window, you will be able to see 
all the components that are available within PCB Wizard.

Step 2 of 10: Adding components

Components within the Gallery are grouped according to their function. At the top of the window, a 
drop-down list box allows you to select which group is shown.

From the Power Supplies group, 
add a Battery component from the 
Gallery to your circuit.

To do this:

Move the mouse over the Battery 
symbol. Press and hold down the 
left mouse button.

With the left mouse button still 
held down, move the mouse to 
drag the symbol onto the circuit.

Finally, release the mouse button 
when the circuit symbol is in the 
required position.

To make the test probe circuit you will also need several other components.

Add a 1 pin Single-In-Line (SIL) from the Input Components group; three Resistors from the 
Passive Components group; two 4011B NAND Gates from the ICs (4000B Series) group and finally 
two LEDs from the Output Components group.

It will help later on if you position 
the components neatly before you 
start adding wires to the circuit.

You can move components by 
clicking on the Select button from 
the top toolbar.

In Select mode the cursor will 
appear as a standard pointer:

Using the above layout as a guide, try repositioning the components. Thinking about the position of 
components at the start can help produce a much neater circuit diagram.

Once positioned, wire the components together as shown. For more detailed help and information on 
wiring circuits, refer to the topic entitled Wiring components together in the Help.

Pointer cursor
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With the circuit diagram drawn, you can now start to adjust the components.

To complete the test probe circuit, you will 
need to change the colour of one of the LEDs.

It is important that you select the correct LED. 
You need to choose the LED that is at the 
bottom of the circuit and whose negative side 
connects to the negative side of the battery 
(this would be ground or zero volts). 

Step 3 of 10: Changing component values and models

In your circuit, resistors R1 and R2 will 
be used to limit the amount of current 
that passes through the two LEDs. It is 
good practice to include current-limiting 
resistors when using LEDs; without 
them, LEDs may be damaged or even 
destroyed.

As a 9 volt battery has been used, the 
value of this current limiting resistor will 
need to be changed to 680 ohms which 
would limit the current flowing through 
the LED to about 10mA (milli-amps).

Double-click on resistor R1 to display the Resistor Properties window (above).

The Value field for the resistor is shown at the bottom of the window and consists of both a value and 
a multiplier. The resistor's value (in ohms) is calculated by multiplying the value by the multiplier. 

Enter 680 in the first value box and then click once on the down arrow to the right of the second box 
to change the multiplier from K (x 1,000) to blank (x 1).

Change the value of resistor R2 to 680 ohms in the same way.

Based on the circuit shown above, it would be 
LED D2. Note that your circuit might use different 
numbers for the components.

Click the right mouse button over the LED and, 
from the pop-up menu that appears, choose 
Green from the Models list.

Value Multiplier, where:
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Now that the test probe circuit is complete, you can convert it into a printed circuit board.

From the Tools menu choose Convert | Design to Printed Circuit 
Board. You will see a window appear to lead you through the 
conversion process. The window contains a series of pages that allow 
you to decide how your circuit is converted.

For more information on the options available for converting your circuit diagrams into PCB 
layouts, see the topic entitled Converting to a PCB layout in the Help.

Step 4 of 10: Converting the circuit into a PCB layout (1) 

Click on the Next button to see a page of options controlling component placement.

Because the test probe will need an unusual shape for the board, you will need to position the 
components yourself. Click on the Automatically place components on the board option to 
disable automatic component placement. You will see all of the other options become disabled.

Click on the Next button again to proceed to the last page of options (pages for controlling automatic 
routing and copper areas will be skipped since they require component placement to be enabled).

Click on the Next button to show the first page of options. Set the board size to be calculated 
automatically and then click on the Next button two more times.

You will then see the page shown below. As your test probe circuit contains digital components (the 
two 4011B NAND gates), you will need to connect these components to a power supply.

You will notice that a power supply (your battery B1) has been automatically detected—the NAND 
gates will be connected to the positive and negative sides of the battery.
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Step 5 of 10: Converting the circuit into a PCB layout (2) 

With all of the options specified, you are ready to convert your circuit. Click on the Convert button.

PCB Wizard will now create the components for your test probe circuit.

Because the automatic component placement 
option was turned off, the components in your 
circuit are converted into a rats nest.

With a rats nest, green lines, or nets, are used 
to represent the electrical connections between 
components. You will notice that when you 
move a component, any attached nets will stay 
connected and move with the component.

Using the layout on the left as a guide, try 
repositioning the components.

To rotate a component, first click on the 
component to select it and then click on the 
Rotate Left button on the top toolbar:

Remember that if you get stuck, you can always 
just click on the Undo button to correct any 
mistakes:
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Step 6 of 10: Automatically routing the circuit 

Now that the components are in position, the connections need to turned into copper tracks.

During automatic routing a path, or route, is found 
for each connection such that it does not touch any 
existing tracks on your circuit. Unlike wires on a 
circuit diagram, copper tracks on a printed circuit 
board cannot overlap.

To 
To automatically route your circuit, choose Route All 
Nets from the Tools | Auto Route menu.

In the window that appears, select the 0.100" grid with 0.040" tracks option and then click on the 
OK button. Your circuit will be automatically routed.

Next a pad will be added to your test probe circuit. This pad will allow a flying wire to be connected to 
your circuit, providing a zero volt reference point against which the probe signal will be measured.

Click on the Pad button on the top toolbar:

(a)

Now click with the left mouse button on the circuit at 
point (a) as shown of the left. The pad should be 
placed on a track that is connected to the negative 
side of the battery (B1).

You can determine which is the negative side of the 
battery by holding your mouse over the pads of 
component B1. The negative side will be shown as 
pin 2 (these pin numbers will always match those 
shown when you hold your mouse over a pin on the 
circuit diagram).

If the routing is not successful, you can click on the 
Undo button, reposition the components and then try 
to automatically route the connections again.
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Step 7 of 10: Making a non-rectangular board

Printed circuit boards are normally rectangular in shape. The test probe is an example of one of those 
times when it is useful to have a non-rectangular board shape. The tip of the test probe circuit will be 
made into a thin point making it more suitable for use as a handheld device.

Start by adjusting the size of the rectangular 
board so that it neatly fits around the components 
and tracks within your circuit.

To add the tip of the test probe, you need an 
irregularly-shaped board.

Click with the right mouse button over the circuit 
board outline (avoiding the objects that make up 
the circuit inside) and choose Polygon from the 
Shape menu.

To add the tip to the test probe, move the mouse over the edge of the board at the left-hand side 
(once over the edge, the cursor will change shape to become a square).

Now hold down the Ctrl key and press and hold down the left mouse button. With the left mouse 
button still held down, move the mouse left to create a tip to the test probe (a).

(a)

(b)

When you release the mouse button, the tip of the test probe will be shown. You can adjust tip of the 
test probe by clicking on the board and moving the node that appears.

Complete the test probe layout by moving the left-most component (the Probe connection) closer to 
the tip of the test probe (b). You may also need to neaten the track that connects to it.
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When a printed circuit board is eventually manufactured, any space on the PCB layout not containing 
tracks, pads or labels, will be etched away from the copper-clad board.

Each time this happens more of the etching solution is used up. To try and conserve this etching 
solution and reduce the cost of production, you can add areas of solid copper to limit the amount of 
etching that is required.

Step 8 of 10: Adding a copper area

To add a copper area, click on the 
Copper Area button on the top toolbar.

Using the mouse, draw a rectangular copper area covering the main body of the test probe circuit as 
shown above. You should leave a small margin (of about 0.1") between the copper area and the edge 
of the printed circuit board.

Just as with the board outline, you 
will need to use an irregular shape 
to extend the copper area into the 
tip of the test probe.

Click with the right mouse button 
over the copper area (again 
avoiding the objects that make up 
the circuit inside) and choose 
Polygon from the Shape menu.

When you release the mouse button, the shape of the copper area will be changed. Just as with the 
board outline, you can adjust the shape of the copper area by clicking on it with the left mouse button 
and then moving one of the nodes that appear.

Move the mouse over the edge of the copper area at the left-hand side (once over the edge, the cursor 
will change shape to become a square).

Now hold down the Ctrl key and press and hold down the left mouse button. With the left mouse 
button still held down, move the mouse left to extend the copper area into the test probe tip (a).
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Step 9 of 10: Adding text to the PCB layout

Next you will use copper labels to add text to your printed circuit board. Copper labels will help you to 
identify your printed circuit board once it has been manufactured.

To add a copper label choose Copper Label from the Insert menu.

Next, click with the left mouse button somewhere on your circuit (you do not need to be very precise 
as you will be able to reposition the label later). A window will appear allowing you to type text for the 
label and specify the layer on which it will reside (see above).

Enter a caption of 'Test Probe' and then click on the OK button. Your label will 
then appear on the circuit.

Notice how the text in the label has 
been reversed. This is so that the label 
will appear the correct way around 
when the PCB is eventually made. Any 
copper labels placed on the solder side 
layer (the underside of the PCB) are 
automatically reversed.

Position the label neatly on the board. 
Remember that as the label will be 
made of copper (since it is on the 
solder side layer), it must not overlap 
any existing pad or track in your circuit.

Select copper label text
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Step 10 of 10: Viewing how the finished PCB will look

With your printed circuit board now created, you can see how it will look when made.

On the left-hand side of the main PCB Wizard window, you will see the Style toolbar. 
This toolbar shows the different ways in which your circuit can be viewed.

Click on the Real World button. The display of your circuit will change to show you 
how your circuit would look if it were professionally manufactured (a).

Next, click on the Artwork button. You now see the artwork (or mask) for your 
circuit (b). It is this artwork that you would use to make the printed circuit board.

To see how a professionally manufactured circuit would look prior to the components 
being soldered in place (c), click on the Unpopulated button.

Finally, try clicking on the Prototype button. This is how your circuit would look if 
made as a one-off prototype (d).

You can use the above styles to help when manufacturing the finished printed 
circuit board. In particular, the Real World and Unpopulated views of your board 
will show where each component needs to go.

(a)

(b)

(d)

(c)


